
Chicago 17th Edition Cheat Sheet

Notes-Bibliography System Quick Reference

BASIC PAPER FORMAT
Two Citation Systems: - Notes-Bibliography (humanities - literature, history, arts) ←
THIS GUIDE - Author-Date (sciences, social sciences - like APA)

Font & Size: - Times New Roman 12pt (preferred) - OR other readable serif font 12pt

Margins: - 1 inch on all sides

Spacing: - Body text: Double-spaced - Footnotes: Single-spaced within, double-space
between - Bibliography: Single-space within entries, double-space between

Alignment: - Left-aligned (ragged right edge)

Page Numbers: - Arabic numerals (1, 2, 3…) - Top right corner, 0.5 inch from top - Start
numbering from title page (but don’t show number on title page)

Paragraphs: - First line indented 0.5 inch (Tab key)

TITLE PAGE FORMAT
Required elements (all centered, double-spaced):

1. Paper title (about 1/3 down page)
2. Subtitle (if any)
3. Several blank lines
4. “by”
5. Your name
6. Several blank lines
7. Course number and name
8. Professor name
9. Institution name

10. Date

Example:

The American Dream in Modern Literature

by

Sarah Chen

English 305: American Literature
Professor Jennifer Martinez
University of California, Berkeley
May 15, 2024

Title Page Notes: - Counts as page 1 but NO page number shown - Title can be bold or
regular (check instructor preference) - All centered - Double-spaced



BODY TEXT FORMAT
First page of text = Page 2 - Page number shows in top right corner - NO header text,
just page number - Begin text 1 inch from top - First line of paragraphs indented 0.5 inch -
Double-spaced throughout

Footnote Indicators: - Superscript numbers in text - After punctuation (period, comma) -
Consecutive numbering (1, 2, 3…) throughout entire paper - NOT restarting on each page

FOOTNOTES: THE BASICS
Location: - Bottom of same page as reference - Separated from text by short horizontal
line (about 2 inches)

Format: - Number followed by period and space: 1. - First line indented 0.5 inch - Single-
spaced within each footnote - Double-space between footnotes - Same font as body (12pt)
or smaller (10pt acceptable)

First vs. Subsequent Citations: - First time: Full citation with all details - Later times:
Shortened form (Author, Short Title, page)

Example:

First citation:
1. F. Scott Fitzgerald, The Great Gatsby (New York: Scribner, 2004), 98.

Later citation:
5. Fitzgerald, Great Gatsby, 180.

FOOTNOTE CITATION FORMATS

BOOKS

One author (first reference):

1. First name Last name, Book Title (Place: Publisher, Year), page.

Example:
1. F. Scott Fitzgerald, The Great Gatsby (New York: Scribner, 2004), 98.

One author (shortened):

2. Last name, Short Title, page.

Example:
2. Fitzgerald, Great Gatsby, 180.

Two authors:

1. First Author and Second Author, Title (Place: Publisher, Year), page.

Example:
1. Gerald Graff and Cathy Birkenstein, They Say / I Say (New York: W. W. 
Norton, 2018), 45.

Three authors:

1. First Author, Second Author, and Third Author, Title (Place: Publisher, 
Year), page.

Four or more authors:



1. First Author et al., Title (Place: Publisher, Year), page.

Example:
1. David Smith et al., American Literature Survey (Boston: Bedford, 2020), 
234.

Edited book:

1. Editor Name, ed., Book Title (Place: Publisher, Year), page.

Example:
1. Arnold Rampersad, ed., The Collected Poems of Langston Hughes (New 
York: Vintage, 1994), 426.

Chapter in edited book:

1. Author, "Chapter Title," in Book Title, ed. Editor Name (Place: 
Publisher, Year), page.

Example:
1. Brandon King, "The American Dream: Dead, Alive, or on Hold?" in They 
Say / I Say, ed. Gerald Graff (New York: W. W. Norton, 2018), 575.

Translated book:

1. Author, Title, trans. Translator Name (Place: Publisher, Year), page.

Example:
1. Thomas Piketty, Capital in the Twenty-First Century, trans. Arthur 
Goldhammer (Cambridge, MA: Harvard University Press, 2014), 34.

Edition other than first:

1. Author, Title, edition (Place: Publisher, Year), page.

Example:
1. William Strunk and E. B. White, The Elements of Style, 4th ed. (New 
York: Longman, 1999), 23.

E-book:

1. Author, Title (Place: Publisher, Year), format, page/location.

Example:
1. F. Scott Fitzgerald, The Great Gatsby (New York: Scribner, 2004), 
Kindle, loc. 1245.

If no page numbers, cite by chapter or section.

ARTICLES

Journal article:

1. Author, "Article Title," Journal Title volume, no. issue (Date): page.

Example:
1. Emmanuel Saez, "Wealth Inequality in America," Quarterly Journal of 
Economics 131, no. 2 (May 2016): 525.

Journal shortened:

2. Last name, "Short Title," page.

Example:
2. Saez, "Wealth Inequality," 530.

Magazine article:

1. Author, "Article Title," Magazine Title, Date, page.

Example:
1. Mary McCarthy, "Realism in Theater," Harper's Magazine, July 1949, 48.



Newspaper article:

1. Author, "Article Title," Newspaper Name, Date, page or section.

Example:
1. David Brooks, "The American Dream, Deferred," New York Times, May 15, 
2024, A23.

Online article (with URL):

1. Author, "Article Title," Website/Publication, Date, URL.

Example:
1. Ta-Nehisi Coates, "The Case for Reparations," The Atlantic, June 2014, 
https://www.theatlantic.com/magazine/archive/2014/06/the-case-for-
reparations/361631/.

WEBSITES

Web page with author:

1. Author, "Page Title," Website Name, Date, URL.

Example:
1. John Smith, "Understanding Symbolism," Literary Analysis, January 15, 
2024, https://www.litanalysis.com/symbolism.

Web page, no author:

1. "Page Title," Website Name, Date, URL.

Example:
1. "The American Dream," SparkNotes, accessed May 15, 2024, 
https://www.sparknotes.com/lit/gatsby/themes/.

No date (use “accessed”):

1. Author, "Page Title," Website Name, accessed Date, URL.

OTHER SOURCES

Interview (published):

1. Interviewee, interview by Interviewer, Publication, Date, page.

Example:
1. Toni Morrison, interview by Claudia Tate, Black Women Writers at Work 
(New York: Continuum, 1983), 118.

Interview (personal/unpublished):

1. Interviewee, interview by author, Date, Location.

Example:
1. Professor Jennifer Martinez, interview by author, May 10, 2024, 
Berkeley, CA.

Film/Movie:

1. Film Title, directed by Director Name (Year; Place: Studio, Year), 
format.

Example:
1. The Great Gatsby, directed by Baz Luhrmann (2013; Burbank, CA: Warner 
Bros., 2013), DVD.

YouTube video:



1. Creator/Channel, "Video Title," YouTube video, Duration, Date, URL.

Example:
1. CrashCourse, "The Great Gatsby Summary," YouTube video, 5:32, June 15, 
2014, https://www.youtube.com/watch?v=xxxxx.

Podcast episode:

1. Host, "Episode Title," Podcast Name, podcast audio, Duration, Date, 
URL.

Example:
1. Sarah Koenig, "The Alibi," Serial, podcast audio, 53:00, October 3, 
2014, https://serialpodcast.org/season-one/1/the-alibi.

Social media post:

1. Author/Handle, Platform name, Date and time, URL.

Example:
1. Barack Obama (@BarackObama), Twitter post, June 15, 2024, 3:30 p.m., 
https://twitter.com/BarackObama/status/xxxxx.

BIBLIOGRAPHY PAGE
Format Differences from Footnotes:

1. Author names reversed: Last name, First name
2. Periods replace commas between major elements
3. No page numbers (except for articles/chapters - then full range)
4. Hanging indent: First line flush left, rest indented 0.5 inch
5. Alphabetical order: By author’s last name
6. New page: Starts on separate page after body text
7. Title: “Bibliography” centered at top

Spacing: - Single-space within entries - Double-space between entries

BOOKS IN BIBLIOGRAPHY

One author:

Last name, First name. Book Title. Place: Publisher, Year.

Example:
Fitzgerald, F. Scott. The Great Gatsby. New York: Scribner, 2004.

Two authors:

Last, First, and First Last. Title. Place: Publisher, Year.

Example:
Graff, Gerald, and Cathy Birkenstein. They Say / I Say. New York: W. W. 
Norton, 2018.

Three or more authors:

Last, First, Second Name, and Third Name. Title. Place: Publisher, Year.

OR

Last, First, et al. Title. Place: Publisher, Year.

Edited book:



Last, First, ed. Book Title. Place: Publisher, Year.

Example:
Rampersad, Arnold, ed. The Collected Poems of Langston Hughes. New York: 
Vintage Books, 1994.

Chapter in edited book:

Last, First. "Chapter Title." In Book Title, edited by Editor Name, page-
page. Place: Publisher, Year.

Example:
King, Brandon. "The American Dream: Dead, Alive, or on Hold?" In They Say 
/ I Say, edited by Gerald Graff and Cathy Birkenstein, 572-579. New York: 
W. W. Norton, 2018.

ARTICLES IN BIBLIOGRAPHY

Journal article:

Last, First. "Article Title." Journal Title vol, no. issue (Date): page-
page.

Example:
Saez, Emmanuel, and Gabriel Zucman. "Wealth Inequality in the United 
States since 1913." Quarterly Journal of Economics 131, no. 2 (May 2016): 
519-578.

Magazine article:

Last, First. "Article Title." Magazine Title, Date, page-page.

Example:
McCarthy, Mary. "Realism in the American Theater." Harper's Magazine, July 
1949, 45-52.

Newspaper article:

Last, First. "Article Title." Newspaper Name, Date.

Example:
Brooks, David. "The American Dream, Deferred." New York Times, May 15, 
2024.

Online article:

Last, First. "Article Title." Website/Publication, Date. URL.

Example:
Coates, Ta-Nehisi. "The Case for Reparations." The Atlantic, June 2014. 
https://www.theatlantic.com/magazine/archive/2014/06/the-case-for-
reparations/361631/.

SPECIAL SITUATIONS

IBID. (Latin for “in the same place”)

Traditional usage:

1. Fitzgerald, The Great Gatsby, 45.
2. Ibid., 47.  ← Same source, different page
3. Ibid.      ← Same source, same page

Modern preference (17th edition): Use shortened form instead:

1. Fitzgerald, The Great Gatsby, 45.
2. Fitzgerald, The Great Gatsby, 47.



Both are acceptable - check instructor preference.

MULTIPLE WORKS BY SAME AUTHOR

In footnotes: Include title to distinguish:

1. Miller, Death of a Salesman, 23.
2. Miller, Timebends, 45.

In bibliography: List chronologically, use three em dashes (———) for repeated author:

Miller, Arthur. Death of a Salesman. New York: Penguin, 1998.
———. Timebends: A Life. New York: Grove Press, 1987.

NO AUTHOR

In footnotes:

1. "Article Title," Publication, Date, page.

In bibliography: Alphabetize by title (ignore A, An, The):

"Article Title." Publication, Date.

NO PAGE NUMBERS

Web sources without pagination: Omit page number:

1. Author, "Title," Website, Date, URL.

E-books: Cite by chapter, section, or location:

1. Author, Title (Place: Publisher, Year), Kindle, chap. 3.

CLASSICS (Novels, Plays, Poetry)

Novels - include chapter:

1. F. Scott Fitzgerald, The Great Gatsby (New York: Scribner, 2004), 180 
(ch. 9).

Helps readers with different editions.

Plays - cite by act, scene, line:

1. William Shakespeare, Hamlet, act 3, scene 2, lines 115-120.

Poetry - cite by canto, book, or line:

1. Homer, The Iliad, trans. Robert Fagles (New York: Penguin, 1990), bk. 
1, lines 1-7.

Bible:

1. Genesis 1:1 (New Revised Standard Version).

BLOCK QUOTES
Use for quotes of: - 5 or more lines - OR 100+ words

Format: - Indent entire quote 0.5 inch from left margin - Double-spaced - NO quotation
marks - Footnote number after final punctuation

Example:



Text introducing the quote:
     [Indented quote text goes here. Multiple 
     sentences can be included. The entire quote 
     is indented and double-spaced, with no 
     quotation marks used because the block 
     format indicates it is quoted material.]1

Continue regular text here.

ABBREVIATIONS IN CITATIONS
Common Latin abbreviations:

et al. = “and others” (for 4+ authors)
ed. = edited by, editor, edition
trans. = translated by, translator
vol. = volume
no. = number
ch. / chap. = chapter
p. / pp. = page/pages (rarely used in Chicago)
n.d. = no date
ca. = circa (approximately)

Publisher abbreviations: - University Press: Shorten to UP - Oxford University Press →
Oxford UP - University of Chicago Press → University of Chicago Press (exception)

Months: Abbreviate in footnotes/bibliography (except May, June, July): - Jan., Feb., Mar.,
Apr., Aug., Sept., Oct., Nov., Dec.

FOOTNOTES VS. ENDNOTES
Footnotes (recommended): - At bottom of each page - More convenient for readers -
Preferred format

Endnotes (alternative): - All notes at end of paper before bibliography - New page titled
“Notes” - Same numbering system - Same citation format

This guide assumes footnotes.

QUICK COMPARISON: NOTES-
BIBLIOGRAPHY VS. AUTHOR-DATE

Element Notes-Bibliography Author-Date
Used for Humanities Sciences/Social Sciences
In-text Superscript numbers (Author Year, page)
End material Bibliography Reference List
Detail level More detailed More concise
Similar to Unique to Chicago Similar to APA

This guide covers Notes-Bibliography only.

FORMATTING TIPS

SETTING UP FOOTNOTES IN WORD



1. Place cursor where you want footnote number
2. References tab → Insert Footnote
3. Type your citation in footnote area
4. Word automatically numbers sequentially

CREATING HANGING INDENT (BIBLIOGRAPHY)

Microsoft Word: 1. Select bibliography entries 2. Right-click → Paragraph 3. Indentation
→ Special → Hanging 4. Set to 0.5 inch 5. OK

OR press Ctrl + T (Windows) / Cmd + T (Mac)

Google Docs: 1. Select entries 2. Format → Align & indent → Indentation options 3.
Special indent → Hanging 4. Set to 0.5 inch

SEPARATOR LINE ABOVE FOOTNOTES

Microsoft Word: 1. View → Draft mode 2. References → Show Notes 3. Click “Footnote
Separator” 4. Edit line (should be about 2 inches)

OR

Insert → Shapes → Line (draw manually at bottom of page)

GRAMMAR & STYLE NOTES
Verb tense for literature: - Use present tense: “Fitzgerald describes…” - NOT past tense:
“Fitzgerald described…”

Referring to authors: - First mention: Full name - Subsequent: Last name only

Titles in text: - Books/long works: Italics - Articles/short works: “Quotation Marks”

Numbers: - Spell out: one through ninety-nine - Use numerals: 100 and above -
Exceptions: Dates, measurements, percentages

COMMON CHICAGO ERRORS
� Using parenthetical citations (Author, Year) - that’s Author-Date system � Not indenting
first line of footnotes � Forgetting to number title page (it’s page 1 even though number
isn’t shown) � Putting commas where periods should be in bibliography � Not reversing
author names in bibliography � Missing hanging indent in bibliography � Double-spacing
footnotes (should be single-spaced within) � Using different shortened titles for same
source � Not including separator line above footnotes � Numbering footnotes per page
instead of consecutively � Including database names unnecessarily

PRE-SUBMISSION CHECKLIST
TITLE PAGE: ☐ Title centered vertically and horizontally ☐ All required info: name,
course, professor, institution, date ☐ All centered and double-spaced ☐ No page number
showing (but counts as page 1)

BODY TEXT: ☐ Page numbers start with 2 on first page of text ☐ Page numbers in top
right corner ☐ First line of paragraphs indented 0.5 inch ☐ Double-spaced throughout ☐
Footnote numbers in superscript after punctuation

FOOTNOTES: ☐ At bottom of same page as reference ☐ Short separator line above
footnotes ☐ Numbers not superscript (1. not ¹) ☐ First line indented 0.5 inch ☐ Full



citation on first reference ☐ Shortened form for subsequent references ☐ Single-spaced
within each footnote ☐ Double-spaced between footnotes ☐ Consecutive numbering
throughout paper

BIBLIOGRAPHY: ☐ Starts on new page ☐ “Bibliography” centered at top ☐
Alphabetical by author last name ☐ Author names reversed (Last, First) ☐ Hanging indent
(0.5 inch) ☐ Single-space within entries ☐ Double-space between entries ☐ All footnoted
sources included

CONTENT: ☐ All quotes cited ☐ Page numbers included for specific references ☐
Consistent shortened titles ☐ Proper formatting of titles (italics vs. quotes) ☐ Proofread
for typos

WHEN TO USE CHICAGO STYLE
Common in: - History papers - Literature analysis - Art history - Religious studies - Music
history - Philosophy - Some humanities courses

NOT typically used in: - Sciences (use APA or CSE) - Social sciences (use APA) -
Psychology (use APA) - Business (use APA)

Always check with your instructor.

HELPFUL RESOURCES
Official Resources: - The Chicago Manual of Style, 17th edition (2017) - Chicago Style
Q&A: chicagomanualofstyle.org - Chicago Quick Guide:
chicagomanualofstyle.org/tools_citationguide.html

Online Guides: - Purdue OWL Chicago Guide:
owl.purdue.edu/owl/research_and_citation/chicago_manual_17th_edition/ - Library guides
from major universities

Citation Management Software: - Zotero (free, open-source - BEST for Chicago) -
Mendeley (free) - EndNote (paid)

ALWAYS VERIFY citation generator output - they make mistakes!

CHICAGO VS. MLA VS. APA QUICK
COMPARISON

Feature Chicago MLA APA

Citation method Footnotes/endnotes In-text (Author
page)

In-text
(Author, year)

End list Bibliography Works Cited References
Author format Normal order in notes Last, First Last, Initial
Title page Yes No Yes (varies)
Page numbers Top right Top right with name Top right

Used for Humanities Literature/Humanities Sciences/Social
Sciences

QUICK TIPS FOR SUCCESS
✓ Set up template: Save formatted document for reuse ✓ Keep track: List sources as



you research ✓ Be consistent: Pick Ibid. or shortened form, stick with it ✓ Verify
online citations: Double-check URLs work ✓ Use proper dashes: Em dash (—) not
hyphen (-) ✓ Proofread footnotes: Easy to overlook ✓ Check title formatting: Italics
for books, quotes for articles ✓ Save often: Don’t lose footnote work ✓ Ask
instructor: Some have specific preferences ✓ Start bibliography early: Add sources as
you go

MOST IMPORTANT RULES
1. First footnote: Full citation with all details
2. Subsequent footnotes: Shortened form (Author, Title, page)
3. Bibliography: Author name reversed, periods between elements
4. Consistency: Same format throughout entire paper
5. Page numbers: Include for all specific references
6. Hanging indent: Required for bibliography

WHEN IN DOUBT
1. Consult Chicago Manual (17th ed.) - Official authority
2. Ask your professor - They may have preferences
3. Check Purdue OWL - Excellent free resource
4. Be consistent - Pick one format, use it throughout
5. Cite everything - When unsure, include citation

PRINT THIS CHEAT SHEET FOR QUICK REFERENCE!

Remember: This is a quick guide for Notes-Bibliography system. For comprehensive
rules, unusual sources, or Author-Date system, consult The Chicago Manual of
Style, 17th edition.

Master citation format = Better grades + Academic integrity
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